Accessing MySQL from InfoPath
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1. Introduction
In this tutorial we will show you how to build an InfoPath application to access MySQL via the SOA
Gateway.

2. Prerequisites
It is assumed that you are running the 3 components, MySQL, InfoPath and the SOA Gateway on
Windows.

It is assumed you already have a SOA Gateway server and Control Centre installed. See here for
more info about installing the SOA Gateway.

3. Setup

3.1.InfoPath

Microsoft Office InfoPath is an application used to develop XML-based data entry forms. The
main feature of InfoPath is its ability to author and view XML documents with support for
custom-defined XML schemata. It can connect to external systems using XML Web services
through MSXML and the SOAP Toolkit, and back-end and middle-tier systems can be configured
to communicate by using Web services standards such as SOAP, UDDI, and WSDL.

If you have the MS Office product then you have InfoPath available to you.

3.2.Populate MySQL Database

You will also need a MySQL database. Again, the Open Source version (known as the MySQL
Community Server) can be freely downloaded from the MySQL website. See this link for
download, and here to step you through the installation and configuration.

Now that you’ve got MySQL installed and configured, you will need to populate it with some
demo data. For this we use the RisarisBank sample. This is available here .

e Save this file to “C:\Temp\RisarisBank.sql”
e Connect to the MySQL Server using the mysgl command.

E.g shell> mysql —u root —p

This command connects to the server using the MySQL root account to make sure that
you'll have permission to create the RisarisBank database. The -p option tells mysql
to prompt you for the root password. Enter the password when prompted. (Remember
that the MySQL root account is not the same as the operating system root account
and probably will have a different password.)

e C(Create the RisarisBank database.
mysql> CREATE DATABASE RisarisBank;

mysql> use RisarisBank;
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e Load the contents of RisarisBank.sql into the RisarisBank database. E.g.
mysql> SOURCE c:\Temp\RisarisBank.sql

e After the SOURCE command finishes, you can view your new tables.
mysql> SHOW TABLES;
mysql> DESCRIBE CustomerInformation;
mysql> DESCRIBE Branch;

etc...

3.3.Set up ODBC Access
The final thing to do with your MySQL Database is to set up an ODBC DSN which will be used by
the SOA Gateway to access this database.

Click Start, Control Panel, Administrative Tools, Data Sources (ODBC)
From the resulting screen, choose the “System DSN” Tab.

Click Add

From the list of data source drivers, select “MySQL ODBC 3.51 Driver”.

If you do not see this driver in the list, you need to install the MySQL Connector. See here for
more information. We recommend installing v3.51.

Click Finish, and a window will appear allowing you to enter the DSN information. Add the

following:
Data Source Name: RisarisBank
Description: The Risaris Bank Sample in MySQL
Server: localhost
User: root
Password: *** your MySQL root password ***

Database: RisarisBank (select from the drop down list)
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nl:unnectur,.-"DDBE 3.51.20 - Add Data Source Mame
™
Connector/0DBC Erought to vou by the database el
VI
Login | Connect Cptions I Advanced I
Database
Daka Source Marme |RisarisBank
Description |The Risaris Bank Sample in My3S0L The database to be current upon connect.
Server I localhost
Optional Yes
Default [none]
ser Iru:u:ut
Password | s
Datahase I RisarisBank] ;I
Test Diagnostics == | (0] 3 Zancel Help

All other options can be left as-is. Click OK.

4. Discovery

At this stage you’ve got InfoPath installed, and a MySQL database with some sample data in it. In this
section we’ll show you how to create web services from each of the MySQL tables. These web
services can be used by the InfoPath language (and many others) to give you direct real-time access
to your MySQL Data.

4.1.Web Service Creation using SOA Gateway
Start your SOA Gateway Control Centre. See here for an introduction to the Control Centre.

In your servers view, right click the entry which represents your local SOA Gateway Server. Select
“Create New Web Services”.
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e —_
.. SDA Gateway Servers (. Eq fit 50A Gateway Sery

«> ¥ ¥ | WebServices I[)ata'lu

Name | M... | ASY | Tracing | il L| Driver
ALY Server Y  OFF/7T

= Lm:al Server
2/05 Server t:gh Refresh Configuration

Suspend Server

2] set Credentials For Server

VAJ Save current Configuration ko server File
& | Import Configuration into Control Center

& Export Configuration from Control Center

5 Export WebService Definition(s) to server

¥ Remove Server definition

&5 Add new S04 Gakeway conneckion

=

From the next dialog, choose “MySQL Driver”. If you do not see have a MySQL Driver in the list,
see how to create one here.

.5!]A Gateway - WebService creation |

This wizard will guide you through the process
of generating new WebServices.

Select the source of data [YFESTR T - =
Discovery timeout fsecunlgu

Mexkt > | Done |

Click Next.

The next screen gives you the ability to add information about your DSN
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!SDA Gateway WebService Creation {mysql) Ed

Step 1 - select input

—Specify ODBC descriptors & option(s)

ODBC Dsn IRisarisBank
Userld / Passwurdlruut I- I
Pattern I
Max.entries to list I
— Options for generated WebSeryice name
Advanced Options O
Discover Cancel
Enter the above information and click Discover.
The wizard will display all the tables it finds at this (RisarisBank) DSN.
Click “Select All”, and click “Import”.
The wizard will create web services from each one of these tables.
.. SOA Gateway Servers &8 = 0| soa Gateway Server Configuration - Local Server &3
+5 f* 7 || webServices | Dataviews / XDs / X5Ls |
Name | M... | ASy | Mod | Driy‘er | WebService | DataSource Id | Data¥iew |
AlLX Server Y ™ _| MySQL Driver accountsmovements odbeD: isBank, tablef count: 5 account: 5
DMZ Y ~
dublin dey ¥ wigsct MySQL Driver audit odbcD: isBank, t dil audit
jk server ¥ My N MySOQL Driver branch odbcDsn=RisarisBank, tableName =branch branch
jk server linux Y ™
AETT ¥ wyeo: MySQL Driver currentaccount odbcDsn=RisarisBank, tableName =currentaccount currentaccount
> Local Server ¥ My th MySOL Driver customeraccountxref odbcDsn=RisarisBank, tableName =customeraccountxref customeraccountxref
:;Rrj\;:rver : My N MySOQL Driver customerinformation odbcDsn=RisarisBank, tableName =customerinformation customerinformation
risaris.com server ¥ Wiy I MyS0OL Driver depositaccount odbcD: isBank, t depositaccount depositaccount
:;;S Server : My t MySOL Driver tellertable odbcDsn=RisarisBank, tableName =tellertable tellertable
z/wse Y

You've just created 8 Web Services from your 8 MySQL Tables!

4.2.Accessing the WSDL
Web Service Description Language (WSDL) is a standard, XML-based language that is used to

describe a Web Service.

For each of the 8 web services you’ve created in the previous section, the SOA Gateway provides
you with a WSDL to describe the Web Service. The WSDL itself is usually interpreted by a web
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service client, such as InfoPath, but it is useful to know where to find the WSDL for each of your

Web Services.

As WSDL is XML-based, it will open in your browser of choice. To see the WSDL for one of your

Risaris Bank web services, do the following in your SOA Gateway Control Centre:

e Click on the web service you are interested in, for example the “branch” web service.

e The properties for this web service should appear in your Properties View. If you do not
see the Properties view, select Window -> Show View -> Other -> General -> Properties

and click OK.

e Inthe properties view, there is a link to your WSDL. Click it to open the WSDL in a

browser.

... SOA Gateway Server Configuration - Local Server 3

WebServices | DataViews / XSDs / XSLs |

| WehService

| DataSource Id

Mod | Driver
e MySQL Driver
sysoct MySQL Driver
syeoc | MySOL Driver
wgso MySOQL Driver
wgeo MySOQL Driver
wigsct MySOL Driver
sgsos MySQL Driver

syso MySOQL Driver

accountsmovements
audit

branch
currentaccount
customeraccountsref
customerinformation
depositaccount

tellertable

odbcDsn=RisarisBank, tableNi
odbcDsn=RisarisBank, tableMi
odbcDsn=RisarisBank, tableMi
odbcDsn=RisarisBank, tableM:
odbcDsn=RisarisBank, tableM:
odbcDsn=RisarisBank, tableNi
odbcDsn=RisarisBank, tableM:

odbcDsn=RisarisBank, tableMi

| Server name

... SOA Gateway Action Log 22
| Me- sage

i Local Server

i Local Server

i N ..

£ Properties &3

webService properties

Hliscovery completed, 8 WebService(s) generated

‘ation autosaved due to published WebService modification{s)

TR R T |
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S| :
Resource - WebService ) /
Name Ihranch
Dataview Ihranch j
Drivel IM‘J"5Q|- Driver "I SBCS-Codepage I—

Read-only []

MBCS-Codepage I

WSDL URL is . http:/localhost:56000, branch?WsDL

= WebService Identification and options

odbcDsn |RisarisBank
schemaMName I
tableName Ihranch
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You can view the WSDL for the other web services by clicking the link from their properties
view.

This WSDL is the starting point for using Web Services, and can be used time and again by
different web service clients.

5. Accessing Web Service with InfoPath

5.1.Procedure
When InfoPath is first opened, it displays the following dialog box. Select the Design a Form
Template... option.

Getting Started M

Form categories Customize a Sample

Form tasks

Recently Used Forms = Fill Out this Form

Favorites p— ) Add to Favorites
all Forms Design this form
Remove this form
Open a form Get update of this form
oe2 Sample -Expense  Sample - Meeting g Get Updates of Forms in this
template Report Agenda Categaory
Documents
Templahe 1

[3 On My Computer...

Design a form

Q Design & Form Template. ..

':?.j Import & Form. .. Sample - Status Sample - Travel

Report Request

| Customize a Sample

Form Templates on Office Online

Next select Web Service as the form template required and hit OK.
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Design a Form Template @&J

Open a form template Design a new:
[£5 On My Computer... (@) Form Template () Template Part
On a SharePoint Site. ., A form template can be shared or published to gather data from users who fill out the
form.

E] Customize a Sample. ..
Based on;

D}‘ Forms on Office Online

f I Create a form template that
=y Import... I ‘?1? I.__J queries and submits data to a
' Web service.
Recent form templates Blank Database
DB2

Documents % Ijﬁ
(B . r

Template1 ) ]
¥ML or Schema  Connection

Fill out a form Library

= Fill Quta Form...

Enable browser-compatible features only

Ok l [ Cancel

Select Next.

Data Connection Wizard @Iﬂ_hj

Specfy how the form works with the Web Service.

Do you want the form to both receive data from and submit data to the Web service, only to
submit data, or only to receive data?

(@ Receive and submit data
() Submit data
(7) Receive data

Enter the URL of the customer information web service. Change the server/port as appropriate

to your environment. Hit Next.
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Data Connection Wizard

Web service detzils (receive data)
Use these options to specify the Web service from which you receive data.

Enter the location of the Web service you want to use as your data connection:
| hittp: /localhost: 56000 feustomerinformation?WsDL | &e_mh UDDL...

Example: http:/fwww. contoso.comfService. asmx?WSDL

A list of web service methods is listed as shown. In this example we chose list. Hit Next.

Data Connection Wizard m

The Web service that you selected has the following operations for providing the XML data that
your form receives,

Select an operation: Description of operation:
update
add

delete

iet

Change the query name if required. Hit Next.
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Data Connection Wizard m

Enter a name for the data connection for receiving data:

|Mair1 query

Summary

Type: Retrieve data
Web service: hitp:/flocalhost: 56000 /customerinformation

_:‘ Operation: list
| —

% To set up the data connection for submitting data, dick Mext.

fosBad ] [ dext> | [ concel |

You can now enter the web service for data submission. In this instance it is as before so hit
Next.

[ o |

Web service details (submit data)
lUse these options to spedfy the Web service to which you submit data.

Enter the location of the Web service you want users to submit their forms to:
| http:/flocalhost: 56000 jcustomerinformation?WSDL | [ Search UDDL...

Example: http:/fwww.contoso.com/Service. asmx?WSDL

Select list and hit Next.
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Data Connection Wizard m

The Web service that you selected has the following operations for submitting your XML data to.

Select an operation: Description of operation:

update
add
delete

iet

For the parameter dialog select Entire form and hit Next.

Data Connection Wizard m

The submit operation for the Web service requires the following parameters. Specify which fields or
groups in your form provide the data for these parameters, If the Web service parameter requires
an entire XML document, you can spedify that as well,

Parameters:

Parameter Type
:CustomerMumber string

Parameter options
Submit the following data for the selected parameter:
©) Bield or group: |

Include: IText and child elements only

(@) Entire form (%ML document, induding processing instructions);

[ submit data as a string
Mote: Digitally signed data must be submitted as a string to preserve white spaces.

[ <geck | [ mewt> |[ concel

Finally choose a name for the submit query or accept default name and hit Finish.
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Data Connection Wizard @lﬁ

Enter a name for the data connection for submitting data:

Main submit

Summary

Type: Submit data
Web service: hitp:/flocalhost: 56000 /customerinformation
Operation: list

< Back

5.2.Form details
The form template is now displayed as shown below. Note that we have opened the queryFields
and the dataFields datasources to show the input parameter and the output from the query.

[E] (Design) Templatel - Microsoft Office InfoPath I . » Peen 5 4 e == g
! File Edit View Inset Format Tools Table Help Type a question for help -
PRI RS L By Preview - (g8 (3 Y % Ca @ F |9 @ @ & | DesignTasks.. | @ -
4[; Verdana - 10 - = -

: %] Draw Table [{ Mo border

-:
: Data Source v X

Lo
Click to add a title g

- ~ Design Tasks
Click to add form content b £
-------------------------------------------------------------------------------------- Data source:

1 T Main

| [= [ myFields
i = (8 queryFields
' = [F asg:customerinformationGroupListElement
(=8 :Customerhumber
= [§ dataFields
= [F asg:customerinformationRootElement
= [=§ :customerinformationRoot
= gf customerinformationGroup

(=B CustomerMumber
(=H Firsthiame
.‘_'_? Surname
(=B AddressLine1
(=8 Addressline2
=F aity
! ! (= Postcode .
''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' (=B DateOfBirth i

3

m

[ show details
Actions

Manage Data Connections...

(@) Help with the Data Source

Compatibility: InfoPath and InfoPath Forms Services
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Add a form title e.g. Risaris Bank Demo if required.
Drag CustomerNumber of queryFields to the Drag query fields here box.

Drag customerinformationGroup to the Drag data fields here box. When presented with the
option select Repeating Table. The form should now look like this:

L= (Design) Templatel - Microsoft Office InfoPath WL TR & @i g e (= [ B [
File Edit View Insert Format Tools Table Help Type a question for help -
.g] B = L | 2y Preview - @ -5 A EER - A N ] & 3 & IingesigﬂTasks.‘. 7] =
i A4 Verdana - 10 - B I U EEEE|E- =iz E a7 . A .
H o
ElﬁDraﬂTable I_f Mo border - |1 pt v|__ - 3. Insert~ 5 ﬁ = @z =
“ |} Data Source - x
‘Risaris Bank Demo ©16|a
! [igj Design Tasks
''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''''' Data source:
Customer Number: =
' 5 = myFields (=] «
= [£§ queryFields b
= [=F asg:a informationGroupListEl it
(=R :CustomerMumber
___________________________________________________________________________________________ = [0 dataFields

= [£F asg:customerinformationRootElement
= [£8 :customerinformationRoot
2 gf customerinformationGroup =

First
Name

Address
Line 2

Surname Address
Line 1

Customer
Number

CustomerMumber
Firsthame
Surname
AddressLine1
AddressLine2
City

Postcode

oo : (=8 DateOfBirth -

[T show details
Actions

Add a Field or Group...
Manage Data Connections...

@ Help with the Data Source

Compatibility: InfoPath and InfoPath Forms Services

The default security setting for InfoPath is quite restrictive so it is almost certain that you will
have to perform the next steps prior to previewing the form.

5.3.Trust
From the Tools menu go to Form Options... and select Security and Trust as shown.
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ch:rm Options -~ ‘ - . . " . @lﬁ

Category:

Browser . ;

Open and Save Security Level

Offline Form template requires the following level of trust from the user:

E-Mail .ﬁ.tlﬁn:hments Autormatically determine security level (recommended)

Property Promotion ) . ) _ .

Digital Signatures Restricted (the form cannot access content outside the form)
Security and Trust (@ Domain (the form can access content from the domain in which it is located)
Preview

Programming Eull Trust (the form has access to files and settings on the computer)
Versioning For a form to run with full trust in InfoPath, it must be installed or digitally signed
Compatibility with a certificate. To preview or debug a form with full trust, this is not
Advanced necessary. Browser-enabled form templates require full trust if they contain code,

and must be deployed by a server administrator.
Form Template Signature

Spedfy a certificate to digitally sign this form template. Signed form templates can be
made fully trusted and can be automatically updated when sent as e-mail attachments.

[ sign this form template
. Mame
Issued by

Expiration date

Select Certificate. .. Create Certificate. .. View Certificate...

[ Ok J [ Cancel

Deselect Automatically determine security level and select the Full Trust option as below. Hit OK.
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r

Form Options . . @lﬂ_hj

Category:

Browser -

Open and Save Security Level

Offline Form template requires the following level of trust from the user:

E‘Ma“ Attpadﬁme;ts [] Automatically determine security level (recommended)

roperty Promation i

Digiial ggnab_lres (") Restricted (the form cannot access content outside the form)

Security and Trust () Domain (the form can access content from the domain in which it is located)
Preview _

Programming i@ Full Trust (the form has access to files and settings on the computer):
Versioning For a form to run with full trust in InfoPath, it must be installed or digitally signed
Compatibility with a certificate. To preview or debug a form with full trust, this is not
Advanced necessary. Browser-enabled form templates require full trust if they contain code,

and must be deployed by a server administrator.
Form Template Signature

Spedfy a certificate to digitally sign this form template. Signed form templates can be
made fully trusted and can be automatically updated when sent as e-mail attachments.

[ sign this form template

B

[¥5]
m
m
i
(]
!
)
I
|5 1]
m
(]
m
i
m
m
[s1]
m

oK ] [ Cancel

5.4.MySQL security

At this point, depending on your MySQL security settings, you may have an issue accessing the
RisarisBank database. Unfortunately InfoPath is very poor at providing an appropriate error
message. It stems from the fact that there is no way to provide a user name or password with
InfoPath so if the database requires them, the query will fail.

A more user friendly way to determine if there is a security issue is to use an application such as
MS Word (see Accessing MySQL from Word). It will inform you, if applicable, of the user and

host involved.

<Title>Error</Title><p>ErrorCode = -11000</p><p>Reason = Mon Apr 21
15:46:20.00595228, pid: 00019601, tid: 00884791. ERROR: in file
src/adaptorImpl.cpp, at line 955.

odbcDSDI: :workerProcessOdbcDiagnostics () returned -11000, indicating
ODBC API "SQLConnect" returned "-1", SQLSTATE is: HY000, Native error
number is: 1044, Message Text is : [unixODBC] [MySQL] [ODBC 5.1
Driver]Access denied for user 'jom'@'localhost' to database
'RisarisBank'</p><p>Mon Apr 21 15:46:20.00595293, pid: 00019601, tid:
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00884791. ERROR: in file src/adaptorImpl.cpp, at line 976.
odbcDSDI: :contextInit () returned -11000, indicating An external ODBC API

call failed. See previous messages.</p>
The following steps should solve this issue:

e Loginto MySQL as user root.
e Issue the following 2 statements substituting ‘jom’@’localhost’ with the user and host in

your error message:

grant SELECT, INSERT, DELETE, UPDATE on RisarisBank.* to 'jom'@'localhost’;
flush privileges;

MySQL selects a user login on a hierarchical basis and you may have to repeat the above for the
next user. Again we would suggest using the Word tutorial until access to the database is

allowed.

If you wish to revoke the assigned privileges do the following:

e Loginto MySQL as user root.
e |ssue the following 2 statements substituting ‘jom’@’localhost’ with the user and host in

your error message:

revoke SELECT, INSERT, DELETE, UPDATE on RisarisBank.* from 'jom'@Ilocalhost;
flush privileges;

Finally select Preview from the toolbar and the following form is displayed.
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mailto:root@localhost
mailto:root@localhost
mailto:root@localhost
mailto:root@localhost
mailto:root@localhost
mailto:root@localhost
mailto:root@localhost

Risaris Bank Demo

Customer Mumber:

Customer First Surname Address Address City Postcode Date
Number Name Line 1 Line 2 Of
Birth

E Insert item

L= (Preview) Templatel - Microsoft Office InfoPath - E@lﬁ
! File Edit View Inset Format Tools Table Help Type a question for help -

 @dSubmit | = 5 [ Ll | B Close Preview | & [ &7 | ¥ B3 & 9 ™[ @ £

i 44 Verdana v”lﬂ | B I O E == |iz-iz-EE (A ;
: # StatInkEntry | @& - 2| - = @ =

@ Form template's location: C\Users'John'AppData\Local\Microsoft\InfoPath' Designer?\ e3cfifal e539f4 a1 8\ ma

The customer number can be wildcarded and in our example below, we are listing those ending
with 4.
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L= (Preview) Templatel - Microsoft Office InfoPath E@&J

© File Edit View Inset Format Tools Table Help Type a question for help -
 @dSubmit | =7 5 [l ) | R ClosePreview | (4 V| % 2 @ F 9 o~ || @ £
4 I B zulss=si=-=-:=-2-A-
E_fStartInl-:Entr_-,r ﬁ - P = | @ e

v

Risaris Bank Demo

Customer Mumber:
*4

Customer First Surname Address Address City Postcode Date

Number Name Line 1 Line 2 Of
Birth

4 Lillian  Margues 1 Father D Bordesley Birm BO4 4LW  14/01/1
14 Alfred Summers: 3701 5. Ge Melbourne Batt BAG BUU 07/08/1
24 Lesley Wells 23 Charlot! Qakham New NWE 3M] 06/05/1
34 Peter Kramer 13 Heronsy Urbana Pres PR4 911 14/07/1
44 Helen Watson 45 South V Carlton Yorl ¥32 7JEW  23/08/1
54 Pauline Goldberg 14 Siddals Kilburn Mot NT9 ZNW 09/05/1

E Insert item

@ Form template's location: C\Users'John'AppData\Local\Microsoft\InfoPath' Designer?\ e3cfifal e539f4 a1 8\ ma

The form is now ready to be published in whatever format available to you.

6. Conclusion

This tutorial has showed you how to access MySQL from InfoPath using the SOA Gateway. As you
can see, you have built a powerful application that uses Web Services to retrieve information in real-
time.
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